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This month, I’ll be looking at 
another dialog that was 

updated with Inkscape 1.3: the 
Object Attributes dialog. This is one 
that I haven’t covered in this series 
before, because, quite frankly, I had 
no idea it even existed! That came 
as quite a surprise to me – after 
more than a decade of writing 
Inkscape tutorials, I thought I’d 
found just about every hidden 
corner of the application, but it 
turns out I was wrong.

The content of this dialog 
changes based on the selected 
object. If a bitmap image is 
selected, then this dialog replaces 
the older ‘Image Properties…’ 
dialog that was available via the 
right-click context menu. In fact it 
replaces it to the extent that it still 
appears in the context menu with 

the same label, but the dialog that 
opens is definitely now ‘Object 
Attributes’.

At the top of the dialog is a 
thumbnail of the image, together 
with its dimensions and a label to 
indicate whether it’s linked or 
embedded. In the latter case, the 
label also shows the amount of 
space the image data takes up, to 
give you an idea of how much it will 
bloat your SVG file size. The text 
beneath the thumbnail shows the 
image’s ID, prefixed by a hash 
character. This is a little misleading, 
as the default for showing the ID in 
the Object Properties dialog is to 

not include a hash, whereas the 
placeholder text for the ‘Label’ 
field does include it.

Even if you set a label via this 
field in the Object Properties 
dialog, it is not displayed in the 
Object Attributes dialog. I guess 
the Inkscape developers must have 
their own idea of what’s a property 
and what’s an attribute, and only 
the ID counts as the latter.

Moving on down the dialog, the 
URL field shows the path to the 
linked image. For an embedded 
image, this field is disabled. 
Although the field is editable for a 
linked image, changes made here 
are not reflected in the stored data 
for the image in the SVG file. If, as I 
do, you keep your linked bitmaps in 
the same folder as their SVG file, 
you can sometimes find that 
moving or copying SVGs results in 
them being linked to the wrong 
place, via an absolute path. In older 
versions it was possible to directly 
edit the link via this dialog, 
replacing the absolute path with a 
local filename. Not any more.

Instead you have to use the 
button to the right of the URL field 
which allows you to select a 
different image to replace the 
linked or embedded one. Even 
using this to select a file in the 
same directory as the SVG results in 
an absolute ‘file://…’ URL rather 
than a simple filename. This is 
definitely something to be aware 
of, as it not only results in less 
transportable files (ie. just sending 
someone the directory containing 
both the SVG and the bitmaps 
probably won’t work), but also 
leaks information about the folder 
structure on your machine, which 
might be considered a security risk, 
albeit a relatively minor one. On 
reloading your SVG file you may 
find that Inkscape does replace the 
URL with a simple filename if 
they’re in the same directory, but I 
was unable to find any reliable, 
repeatable steps that would 
consistently make this happen 
across the files I tested with. The 
only way to really be sure is to edit 
any linked image paths directly in 
the XML editor.

The buttons below the URL field 
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allow you to convert a linked image 
to an embedded one, or to export a 
copy of the image – regardless of 
whether it’s linked or embedded – 
to a new location. One use of this 
might be to save a copy of an 
embedded file, then use the folder 
icon next to the URL to replace the 
embedded file with a link to the 
external copy you just saved. A 
button to achieve this with a single 
click would be nice, though – 
making it just as easy to un-embed 
an image as it is to embed one.

A welcome addition is the pair 
of radio buttons to select between 
preserving the aspect ratio of the 
image, or stretching it out of 
proportion if necessary. I’d like to 
see buttons to revert to the original 
dimensions, or to keep the width or 
height fixed while changing the 
other dimension to suit the original 
proportions. Being able to preserve 
the aspect ratio allows you to 
address most of the issues for 
which such buttons would be of 
benefit, though, turning these 
tasks from ‘almost impossible’ to 
just ‘a bit tricky’. Finally, a popup 
lets you select between different 
rendering hints. This is the same as 
the ‘Image Rendering’ popup you 
can see in the Object Properties 
dialog. Note that selecting any of 

the options in this menu really is 
just a hint; whether or not they’re 
honored will depend on the 
software being used to display or 
print the SVG.

But what if you want to view the 
Object Attributes dialog for 
something other than an image? 
Common sense would say that you 
just right-click on the object and 
select it from the context menu? Or 
choose it from the main ‘Object’ 
menu, right? Common sense, it 
would seem, is a little short among 
the Inkscape UX team in this case, 
as neither of these menus contain 
an entry for this dialog.

One way to get to it is to use the 
Image Properties menu option on a 
raster image, then select the object 
you’re actually interested in. The 
dialog will change dynamically as 
objects are selected, so will update 
to reflect the non-image item 
you’ve chosen. But that’s hardly an 
effective way to get to this dialog, 
and your drawing might not even 
contain any bitmaps that you can 
right-click on.

Instead, the official way to open 
this dialog is to either bind it to a 
keyboard shortcut via Preferences 
dialog (in the Interface > Keyboard 

pane), or access it via the ‘dialog 
popup menu’. The what now? If 
you’ve no idea what I’m talking 
about, you’re not alone – I also had 
to go hunting to find this menu, as 
it wasn’t a term I was familiar with.

When you open a dialog – any 
dialog – within Inkscape, there is an 
icon at the right of the tab bar 
(circled top right). This is present 
whether the dialog is opened in a 
window, or docked to Inkscape’s 
main window. With the theme I use, 
this icon appears as a light grey 
down-facing arrow which is very 
easy to miss. Here it is at the top-
right of the Fill & Stroke dialog on 
my machine, circled in red because 
it really is so easy to miss.

 Clicking this icon opens the 
‘dialog popup menu’ (right).

In my defence, I was vaguely 
aware of this menu, but it’s not one 
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I ever use. The top few entries are 
useful if you’re managing multiple 
dialogs in a tabbed interface which 
is probably docked to the main 
window. That’s not the way I work. 
The remaining entries open various 
dialogs, but I always open my 
dialogs via toolbar buttons, menus, 
and context menus. Never by 
clicking on a faint icon in some 
completely different dialog, then 
selecting the thing I really wanted 
via this menu.

Towards the bottom of the 
dialog, in the ‘Settings’ section, you 
can find the entry for Object 
Attributes. If you don’t have a 
bitmap image in your document, 
and haven’t bound a separate 
keyboard shortcut, this seems to be 
the only way to access it. To 
summarise, the steps required are:

•  Open a dialog. Any one will do, 
so feel free to use the “Layers and 
Objects”, “Fill and Stroke”, or “Align 
and Distribute” dialogs if they’re 
already open. If you don’t have a 
dialog open, right-clicking on an 
object and choosing “Document 
Properties” feels to me like a route 
that won’t break the mental 
context of what you’re trying to do.
•  Click on the icon at the right of 
the tab bar in your selected dialog.

•  Click on “Object Attributes” in the 
Settings section of the menu.
•  On the canvas, select the object 
whose attributes you wish to view 
or edit.
•  Optionally close the other dialog 
if you no longer require it.

With nothing selected, the 
dialog is empty, and with multiple 
objects selected, it simply shows 
the text “Multiple objects 
selected”. When an individual 
object is selected, however, the 
display will change depending on 
the type of object. We’ve already 
seen how it looks when a bitmap 
image is chosen, but here are the 
other possibilities:

Essentially these replicate the 
controls in the relevant tool control 
bar for each type of object, but 
there are some interesting 
additions and differences. First is 
that the object’s fill and stroke 
colors, and stroke width, are 
indicated at the top-right of each 
view. None of the other stroke 
properties are reflected here, and 
unlike the corresponding swatches 
and numbers in the status bar, you 
can’t change the values in any way 
from here. Disappointingly, clicking 
on the swatches doesn’t even open 
the Fill & Stroke dialog.

The top row of fields for 
Rectangles and Ellipses has a small 
icon to the right. Clicking this will 
round the values in those fields to 
the nearest integer, which is a 
potentially handy feature that 
would be nice to have in the main 
tool control bar fields. Conversely, 
the quick shortcut values that are 
present on the context menus for 
these fields in the tool control bar 
are not included within this dialog. 
That limitation applies to all the 
fields, regardless of the selected 
object.

The Rectangle pane has a couple 
of buttons at the bottom. The first 

sets the corner radius values to 
zero (i.e. 90° corners) as it does in 
the tool control bar. But the second 
button is another useful one which 
is missing from the tool control bar: 
it adds the ‘Corners’ live path 
effect, allowing each of the four 
corner radii to be modified 
independently. The Object 
Attributes dialog does not actually 
show the individual values, however 
– this button is more of a quick way 
to add the LPE so you can tweak 
the values on-canvas, but you’ll still 
need to open the LPE dialog for 
fine control and editing.

The Star pane also has a couple 
of extra touches compared to the 
regular tool control bar. The first is 
the third button in the ‘Shape’ row 
– whose drab icon in this theme 
makes it appear disabled, even 
though it isn’t. The tooltip in this 
button says ‘Level shape’, which in 
this case means that it will be 
rotated such that the first spoke 
runs vertically. Inkscape veterans 
already know to hold the CTRL key 
and drag upwards when using the 
Star tool to achieve this type of 
alignment, but if you’re not aware 
of that trick, or you simply forget to 
do it on a particular object, 
reorienting a star or regular 
polygon to make it neatly aligned 
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can be a surprisingly tricky task. 
This button achieves it with one 
click, and makes me wonder why 
this isn’t also on the tool control 
bar.

The other feature is less 
impressive, but a nice touch 
nevertheless: next to the last three 
numeric entry fields is a small ‘×’ 
button which appears when these 
fields are set to anything other 
than their default values (0.5, 0 and 
0, respectively). Clicking the button 
simply resets that field back to its 
default.

Missing in this image are the 
Object Attributes panes for Spirals, 
Paths, Text, and 3D Boxes. None of 
these objects show any content at 
all in this dialog – not even the non-
editable fill and stroke information. 
This makes the dialog as a whole 
feel rather unfinished and 
inconsistent. Perhaps that’s why it’s 
been hidden away so well.

In summary, this dialog is a 
potentially useful tool which even 
offers a few capabilities that can’t 
be found anywhere else in 
Inkscape. That makes it all the more 
disappointing that it’s hidden away 
in an obscure popup menu, rather 
than appearing in the context 

menu. This is doubly baffling when 
you consider that it does appear 
there – albeit with a historic title – 
if the selected object happens to be 
a bitmap image. I’m not sure I’ll use 
this dialog enough to warrant 
creating a keybinding for it, but 
now that I know it exists I’ve little 
doubt that I’ll have cause to open it 
from time to time. To be honest, 
that will mostly be when I forgot to 
hold CTRL while creating a star.

Mark uses Inkscape to create comics 
for the web (www.peppertop.com/) 
as well as for print. You can follow 
him on Twitter for more comic and 
Inkscape content: 
@PeppertopComics

https://www.peppertop.com
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This month we’re continuing to 
look at the changes to dialogs 

in Inkscape version 1.3. It’s almost 
become a cliché to see substantial 
changes to the Live Path Effects 
dialog with each significant 
Inkscape release, but here we are 
again with yet another round of UI 
updates. As a reminder, in version 
1.2 the main LPE dialog looked like 
this (once a couple of effects had 
been added):

Clicking the ‘+’ button would 
open a large dialog from which you 
could select the LPE to add, as well 

as search, view the entries as a list, 
or as a more/less compact grid, set 
LPEs as favorites (and filter to show 
only those), and toggle the visibility 
of experimental effects. In fact 
there’s so much functionality baked 
into this UI that I expected it to 
hang around for years to come. 
How wrong I was.

Fast forward to version 1.3. The 
main LPE dialog no longer shows a 
list of the applied effects, with a 
single panel of settings for the 
currently selected one. Instead, the 
configuration panels are shown 
directly, in an ‘accordion’ UI pattern, 
such that by expanding one panel, 
all the others will collapse. You can 

collapse the current panel, too, if 
you just want to see a shorter list of 
effects, which makes it easier to 
reorder them by dragging the 
handle at the top-right of each 
panel.

With this UI, there’s no longer a 
‘+’ button, and no longer a large 
dialog that opens. Instead you have 
two options for selecting the new 
LPE to add:
•  Type something into the search 
box to be presented with an 
alphabetically ordered list of LPEs 
that match the search term. (Hint: if 
you just want to see a list of all of 
them, putting a single space in this 
field seems to do the trick).
•  Click the drop-down button next 
to the search field to be presented 
with a pop-up that contains a 
categorised grid of effects.
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There’s no way to change the 
size or shape of this pop-up, nor the 
spacing between items, so I’m not 
sure how well it will work on small 
screens – especially if you enable 
the experimental LPEs. Speaking of 
which, the option for that is now 
hidden away in the preferences 
dialog: Edit > Preferences > 
Behaviour > Live Path Effects (LPE). 
Enabling the ‘Show experimental 
effects’ checkbox in there will add 
an extra section to the bottom of 
the pop-up. In that same settings 
panel, you’ll find an option to ‘Show 
deprecated LPE gallery’ (i.e. the 
older UI), if you really don’t like the 
new design. Personally I advise 
against switching back, as this 
option – and the whole gallery 
dialog – will certainly be removed in 
a later release. You may as well get 
used to the new approach now, and 
hope that this one finally sticks 
around for a while.

I think hiding the option for 
showing the experimental LPEs was 
a good move. This isn’t something 
that should be temptingly 
presented to novice users every 
time they add an effect. The 
experimental LPEs are marked as 
such for good reason. They should 
only be used with full knowledge of 

the potential problems – not only in 
terms of Inkscape’s stability, but 
also considering possible issues 
loading any files that use them in 
future releases.

Any LPEs that are set as 
favorites, appear in a section at the 
top of the pop-up. Unfortunately 
they no longer appear in their 
categorised sections, and the 
Favorites section is shown in 
alphabetical order, so any sense of 
grouping is lost for these. You can 
either have an LPE categorised or 
flagged as a favorite, not both. The 
list view that drops down when you 
use the search field is purely 
alphabetical, not only lacking the 
categories, but also lacking any 
indication of which effects have 
been set as favorites. It would be 
nice to see favorites displayed with 
a small star or other badge, and I’d 
rather see the list view also 
grouped in the same way as the 
icon pop-up, for consistency.

Without the gallery view, there’s 
a question of how you set (or unset) 
the favorite flag on an effect. 
There’s no context menu available 
in the pop-up – right-clicking on an 
LPE will behave the same as a left-
click, and add it to the list of 
applied effects in the main body of 

the dialog. Instead, you have to add 
the effect to a path (perhaps a 
temporary, sacrificial one), then use 
the new pop-up menu in the 
effect’s controls pane to toggle the 
favorite flag. On my system, there’s 
some oddness with the outline 
style for this pop-up’s button, but it 
still behaves correctly. In this 
screenshot you can see that there’s 
a group of three buttons which are 
visible whether the pane is 
collapsed or open: the first button 
toggles the visibility of the LPE, the 
second deletes it from the list, and 
the third opens the pop-up menu.

The pop-up 
contains a few 
useful options 
for working 
with effects:

‘Duplicate’ is pretty self-
explanatory, but note that the 
duplicated effect will appear 
directly below the original, and you 
may need to move it up or down in 
the list by hand. This can be done by 
dragging with the handle at the 

right, as previously mentioned, or 
you can use the ‘Move up’ and 
‘Move down’ entries in this menu. 
Only valid options are presented, so 
you won’t see ‘Move down’ in the 
menu for the last LPE in the list, for 
example (as in this screenshot).

‘Flatten’ is an interesting new 
addition. It’s always been possible 
to ‘fix’ the output of an LPE chain 
by selecting the Path > Object to 
Path menu option. This changes the 
drawing such that the original path 
is replaced by the result of the 
entire LPE chain. The Flatten option 
does something similar, but it stops 
at the effect on which the option is 
selected, fixing all the effects up to 
and including that one, but leaving 
subsequent parts still as editable 
LPEs. If you use this on the last 
effect in the chain, it’s the same as 
using Object to Path, but this could 
be very useful where you’re sure 
that the first few effects in a chain 
are correct and won’t need to be 
modified, but still want to leave 
yourself with the flexibility of fully 
editable effects for the rest of the 
chain.

‘Set custom defaults’ will use a 
snapshot of the current settings as 
the default values for this particular 
effect in future. If there’s already a 
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snapshot set, this changes to 
‘Forget custom defaults’. Finally we 
have the ‘Set favorite’ option 
(shown with the British English 
spelling of ‘favourite’ in this 
screenshot, as I’m based in the UK). 
If this LPE is already set as a 
favorite then, as you’ve likely 
guessed, this will display ‘Unset 
favorite’ instead.

It’s a little unfortunate that the 
only way to change favorites is to 
first add the effect to a path, 
perhaps only to throw it away again 
afterwards. But changing favorites 
is likely to be a rare enough 
occurrence that this additional step 
probably won’t cause any real 
problems for most users.

I’m going to take a very quick 
look at a second dialog this month: 
the Symbols dialog (Object > 
Symbols). This has seen a bit of UI 
polish with 1.3, with the confusing 
array of buttons for adjusting the 
layout now rationalised into a 
simple pop-up menu. My tip here is 
to leave ‘Zoom to fit’ enabled and 
just tweak the ‘Tile size’ slider to 
adjust the size of the symbols in the 
dialog, which seems to work well 
with the predefined symbols, at 
least.

On that point, version 1.3 ships 
with a vastly increased number of 
symbols (596 of them, to be 
precise), through the addition of 
the ‘SJJB map icons’ set. Of course, 
more symbols are always welcome 
– if they’re high enough quality – so 
it would be nice to see some Open 
Source icon sets, of the sort often 
used in web pages, make their way 
into future releases.

The plus and minus buttons in 
the bottom-left replace the 
similarly-placed buttons from 
previous versions, which were 
always somewhat confusing due to 

less-than-obvious icon designs. 
These buttons only become active 
when the ‘Current document’ set is 
selected in the dialog’s drop-down 
list. Their tooltips have been 
reworded to make their purpose far 
more understandable now:

“Convert selected object(s) to 
symbol” – this will create a symbol 
from the currently selected objects, 
replacing those objects with the 
symbol, in-place. This may be useful 
if you need to use the same icon or 
other design repeatedly within your 
document, though I’d usually just 
stick with clones myself.

“Convert selected symbol to 
object, and all symbols of this type to 
clones of this object” – this one is 
perhaps more useful, allowing you to 
select a symbol in the dialog and 
have the first instance of it on the 
page converted to a real, editable 
object. Any further instances will be 
converted to clones of the object. I 
can see this coming in handy when 
one of the predefined symbols is 
close to your requirements, but 
needs a little tweaking.

Of course these can be used in 
series to first convert an existing 
symbol to an editable object; then 
edit it on-canvas; then convert the 

edited version back to a document-
specific symbol.

Finally I’ll squeeze in one more 
UI addition – though a pop-up 
rather than a dialog. At the top-
right of the canvas, Inkscape has 
always had a rarely used button to 
toggle its behaviour when the 
window size is changed. The default 
is to not do anything much, other 
than to show or hide the relevant 
parts of the canvas to suit the new 
window size. In other words, the 
document is not zoomed in any 
way. The other mode will scale the 
document to suit the new window 
size, which may suit some users 
who always want to see the same 
amount of content, regardless of 
the window size. This feels to me 
like a feature that novice users 
might think they want before they 
discover the myriad ways to zoom 
and pan in Inkscape, and realise 
they’d rather control the zoom 
themselves than have it 
automatically change when they 
resize the window.

This button has now been 
replaced with a pop-up that still 
contains the previous functionality 
via an option at the bottom, but 
which also exposes radio buttons 
and toggles for the many display 
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modes Inkscape now has. 

Note, however, that the ‘Quick 
zoom’ and ‘Quick preview’ entries 
can’t be clicked – they’re just there 
to remind you of the keyboard 
shortcuts. These both work as long 
as the key is held down – though 
you can also trick them into 
operating as on/off toggles by 
focusing another window, or right-
clicking to bring up the context 
menu, while holding the key. In that 
case the ‘temporary’ view will 
remain on releasing the key, and a 
quick jab of it subsequently will 

return you to the previous state.

I’ve covered ‘Quick zoom’ before 
– it zooms the display just enough 
so that the selected object(s) fill 
the available space. ‘Quick preview’ 
is a new addition with 1.3, and 
temporarily hides grids, guidelines, 
selection boxes, and so on. It also 
clips the visible display of objects to 
the page boundary. Essentially it is 
intended to give you a rapid 
preview of how your document 
might look when printed or 
exported, without all the Inkscape-
specific parts that won’t make it to 
the final document.

Mark uses Inkscape to create comics 
for the web (www.peppertop.com/) 
as well as for print. You can follow 
him on Twitter for more comic and 
Inkscape content: 
@PeppertopComics

https://www.peppertop.com
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Anyone who has used Inkscape’s 
text tool extensively is sure to 

have come across the issue of too 
many fonts being listed, making it 
hard to find the one you’re looking 
for. This may be because you’re an 
ardent collector of all manner of 
weird and wonderful typefaces, or 
it might just be because operating 
systems tend to ship with quite a 
range by default. This is definitely 
the case with some Linux 
distributions, which may come with 
a variety of fonts to cater for users 
who need something beyond 
simple Latin text. For example, 

here’s a fragment of the font list 
that Inkscape displays on my British 
English Ubuntu box, on which I’ve 
never knowingly installed non-Latin 
fonts.

See all those ‘Kacst’ prefixed 
entries? A bit of online searching 
reveals that KACST stands for “King 
Abdulaziz City for Science and 
Technology”, and this is a family of 
Arabic typefaces – something that 
the font preview in Inkscape 
doesn’t indicate. Given that my 
ability to write Arabic is totally non-
existent, I don’t really have any 
need for these fonts, but they’re 
also not intrusive enough to my 
day-to-day work that I’ve ever put 
any effort in to remove them. And 
so they just sit there, never used, 
yet taking up space in the font 
drop-down, forcing me to scroll 
further to get to all the later fonts 
in the list.

Professionals in the design 
industry may be familiar with font 
organisers that work at the OS 
level, either included as a native 
part of the operating system or via 
a third-party tool. These allow you 

to create collections of fonts which 
can be enabled or disabled on the 
fly. This might allow you to create a 
base collection of general 
workaday fonts as a single group. 
You could then have another 
collection with some customer-
specific fonts in it, and enable both 
the base and the customer-specific 
one at the same time. This makes it 
more convenient to work on a 
specific customer’s projects, as 
you’re presented with only the 
relevant fonts within your design 
software. It also makes it much 
easier to deal with commercial 
fonts that might be licensed to one 
single customer and which 
shouldn’t be used on other 
projects.

Inkscape 1.3 adds a similar 
capability built directly into the 
application, rather than operating 
at the OS level. By default, you’ll 
still be presented with the 
complete list of all fonts on your 
machine, but the tool control bar 
for the Font tool now features a 
couple of new buttons at the far 
left which help you to work with 
font collections.

Clicking the leftmost button will 
open a pop-up which lists your 
current font collections, plus a 
button for opening the collections 
editor. At the top of this list will 
always be a pair of pseudo-
collections that contain only those 
fonts currently being used in the 
document (‘Document Fonts’), or 
those that you’ve recently used 
across any documents (‘Recently 
Used Fonts’). For a lot of casual 
users, these alone might be 
sufficient to make font selection a 
more sane operation.
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For those who want to go a bit 
further in their font management, 
clicking the button to open the 
collections editor is your route to 
creating as many different 
collections of fonts as you wish, as 
we’ll see shortly. While we’re 
looking at this pop-up, however, it’s 
worth noting two key things about 
font collections:

•  A single font may appear in as 
many (or as few) collections as you 
wish. It’s fine to have your favourite 
handwriting font in both your 
‘Cursive’ and ‘Favourites’ 
collections, while leaving never-
used fonts out of all your custom 
collections entirely.

•  You may select more than one 
collection at a time in this pop-up. 
The list of available fonts will then 
contain an alphabetically sorted 

combination of the fonts across all 
the selected collections, though 
duplicates are removed so that 
each font will appear in the final list 
only once.

Looking at this in practice, 
you’ve already seen how my 
unfiltered list of fonts contains 
many that I’ll never use. If I’m 
working on one of my ‘Elvie’ comics 
(which appear in Linux Pro 
Magazine), then I want to limit the 
fonts to those that are used for the 
strip. This is especially important to 
get right, because Elvie is released 
entirely under a CC-BY-SA licence – 
including the source files – so I use 
only freely licensed fonts that I can 
also distribute alongside the 
artwork itself. In the pop-up, 
therefore, I can select just that one 
collection and my list of fonts 
becomes a whole lot more 
manageable, and my licensing 

concerns become a lot simpler.

Returning to the longer list that 
shows the complete list of fonts 
can be achieved in one of three 
ways:

•  Open the pop-up again, and un-
check all the collections

•  Click on the second button on the 
toolbar, which does the same thing 
with a single click

•  Click the similarly styled ‘Reset 
filters’ button in the ‘Text and Font’ 
dialog

Rather than returning to the 
complete list, you’re also free to 
open the pop-up and toggle any of 
the collections on or off at any 
time. It’s important to note that 
turning collections off here affects 
only the visibility of the fonts in the 
font selection drop-down and in the 
‘Text and Font’ dialog. It doesn’t 
alter your drawing in any way, so 
don’t worry that de-selecting a 
collection will disable or hide any 
existing text in your document.

The ‘Text and Font’ dialog 
(under the ‘Text’ menu, or press 
Ctrl-Shift-T by default) has also 
gained a reset button, as 

mentioned above, as well as a 
‘Collections’ button which opens 
the same pop-up for enabling and 
disabling collections. There’s even a 
count of how many fonts are being 
displayed compared with the total 
you have available. I’m not sure how 
useful that statistic is in practice, 
but at least it acts as an indicator 
that you have one or more 
collections enabled, rather than 
leaving you thinking you’ve lost 
some fonts.

That’s enough about turning 
collections on and off: the question 
now is how you go about creating 
them in the first place? The pop-up 
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features a button at the bottom 
labelled ‘Open Collections Editor’, 
which does indeed open a dialog to 
manage the collections. 
Unfortunately this is where the 
feature begins to lose its polish 
somewhat.

This dialog definitely does its 
job, but it feels like it escaped the 
attention of the UX team who have 
been doing such great work with 
recent Inkscape releases. Even the 
search box and reset button feel a 
bit cramped up in the corner. 
They’re pretty tight to the edge in 
the ‘Text and Font’ dialog, but this 
part of the application reduces 
some already tight spacing even 
further.

It’s easy enough to get past 
minor layout issues like that, but it’s 
when you start to interact with this 

dialog that it becomes especially 
clunky. Initially the Font Collections 
list will just show the pseudo-
collections for recently-used and 
document fonts. Clicking the ‘+’ 
button at the bottom lets you 
create your own custom collection. 
You’ll be presented with a blank 
row in the list, with an input field to 
give it a name. You can actually just 
press Enter and you’ll be left with a 
confusing entry that has no name, 
and to which you can’t add any 
fonts. If you change your mind and 
press the Esc key to cancel the 
operation, you similarly end up with 
a blank entry. So don’t do that: 
make sure to give your collection a 
name as you create it, to avoid 
confusion later.

Your newly created collection 
will appear in the list, but without 
the small disclosure triangle next to 

it. Let’s add some fonts to it, by first 
selecting the collection and… then 
what? My immediate assumption 
was that I would be able to click on 
fonts in the list at the left to toggle 
them on and off: selected fonts 
would be in the collection, while 
unselected fonts wouldn’t. But it 
doesn’t work like that. My next 
attempt was to click on each of the 
fonts I wanted in the collection in 
turn – but that just selects them 
one at a time, and doesn’t add them 
to the collection at all. Perhaps 
double clicking on a font name 
would work? Nope. Select and press 
Enter? Also nope.

Instead you have to drag-and-
drop the fonts from the left-hand 
list into the collection using the 
mouse. One-by-one. There’s no 
multi-selection allowed in the list, 
even if you want to drag a whole 
block of fonts, such as those from 
the same family. Drag-and-drop is 
an awful approach for something 
like this: it’s too easy to slip with 
the mouse and drop your font into 
the wrong collection. By all means 
allow it as an option, but it’s not a 
great design for a dialog in which 
you might be dragging dozens – 
maybe even hundreds – of items, 
one-by-one, to a relatively small 
target.

You can improve your odds once 
the first font has been added by 
opening the collection using the 
newly-appeared disclosure triangle 
on the left. Now the drop target is 
double the size, and grows larger 
still as more fonts are added. As 
you drag fonts over the collection, 
rows and the spaces between them 
get highlighted as a drop target 
indicator. But ignore the fact that 
this indicator changes in a way that 
suggests you can order the entries 
in the collection, because you can’t. 
It doesn’t matter where in the list 
you drop a font, they will appear in 
alphabetical order.

This alphabetical ordering 
extends to the font selection drop-
down in the tool control bar, and to 
the list in the ‘Text and Font’ dialog. 
This means that, although font 
collections allow you to work with 
shorter, curated lists of fonts, you 
still have no way to ensure that 
your preferred fonts always appear 
at the top of the list, especially 
once you begin to enable multiple 
collections. To be fair, such a 
feature would raise other UX 
questions which don’t have clear-
cut answers. But if the developers 
aren’t prepared to tackle those 
questions, the editor shouldn’t 
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work in a way that suggests the 
ability to order the items, even 
though it doesn’t actually allow it.

My next complaint with this 
dialog is that the fonts that have 
been added to a collection appear 
in a greyed-out color, as though 
they’ve been disabled in some way. 
I understand that this is probably to 
distinguish them from the 
collection title, but the indentation 
level is largely sufficient for that 
without giving the impression that 
the fonts are somehow not 
available or not working. Once 
added to a collection, the entry in 
the list also lacks any preview of 
the font (like the one that’s present 
in the left-hand panel). This makes 
it harder to review collections when 
you return to them some time later 
– especially if you have a lot of 
similarly named fonts, as can easily 
happen with some families of 
related designs (such as those 
‘Kacst’ fonts from earlier).

Removing a font from a 
collection is as simple as clicking 
the button at the right of the row, 
or the delete button at the bottom 
when a row is selected – but not by 
pressing the Delete button on the 
keyboard, that would make far too 
much sense. The font is removed 

from the collection immediately, 
with no confirmation. While that 
makes it more immediate when 
initially setting up your collections, 
it also opens up the possibility of a 
mis-click removing the wrong font. 
Perhaps an option to ‘lock’ a 
collection against edits might be a 
useful addition for a future release.

Deleting an entire collection is a 
little more sensible: the button is 
the same, but this time the deletion 
occurs immediately if the collection 
is empty, but with a prompt if it’s 
not. At least that prevents a simple 
mis-click when removing a font 
from deleting an entire collection.

Finally, you’re free to edit the 
collection name whenever you wish, 
even after it’s been created and 
populated. There’s a dedicated 
‘pencil’ button at the bottom of the 
list for this, but just clicking twice 
on a collection name in the list does 
the same job. As does pressing 
Enter when the collection is 
selected.

The fact that they’re so easily 
editable means that you can use 
this as a way to ‘archive’ collections 
that you’re not using at the 
moment, given that there’s no way 
to disable a collection. Prefix them 

with a ‘Z’, for example, to push 
them to the bottom of the list. Or 
perhaps you could use this to 
promote more important 
collections to the top (prefixed with 
an ‘A’ or a punctuation character). 
This possibility relies on the fact 
that collections are also displayed 
in alphabetical order – but, unlike 
fonts, you have control over the 
names you use. Just be aware that 
this sorting is based on alphabetical 
order and doesn’t really have a 
concept of number systems: in this 
case ‘20’ comes between ‘1’ and ‘2’, 
so if you want to use numbered 
prefixes to sort your collections 
into order, make sure to add a zero 
to the start of the single digit 
entries (if you expect to go beyond 
ten).

In general I really like the 
addition of font collections to 
Inkscape. It’s just a shame that the 

UI for managing them is a little 
clunky and too easy to make 
mistakes with. Hopefully this is 
something that will improve in 
time. Even just being able to 
double-click fonts rather than drag-
and-drop them would be a huge 
usability improvement, though I’ll 
also hold out hope for being able to 
disable and lock collections. Who 
knows, perhaps we will be able to 
sort fonts one day – or at least flag 
some of them as favourites to have 
them consistently appear at the top 
of the list.

Mark uses Inkscape to create comics 
for the web (www.peppertop.com/) 
as well as for print. You can follow 
him on Twitter for more comic and 
Inkscape content: 
@PeppertopComics

https://www.peppertop.com
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This month I’m going to rattle 
through a handful of smaller 

improvements in Inkscape 1.3 that 
don’t really warrant an in-depth 
exploration, but which are worth 
calling out nevertheless.

XML EDITOR

This is the dialog we all love to 
hate. Ideally there would never be a 
need to edit a file’s XML data 
directly. Practically, however, there 
are some more advanced tricks that 
can be done only this way, and for 
anyone creating SVG files to be 
manipulated by JavaScript on a web 
page, this can be an invaluable tool.

The most immediately obvious 

change in 1.3 is the addition of 
syntax highlighting to the DOM 
tree in the left-hand pane. This 
makes it much quicker and easier to 
visually distinguish the elements, 
attributes and values – assuming 
you’re familiar enough with XML to 
know what those terms mean.

The toggle to switch between 
horizontal and vertical layout has 
been moved into a drop-down at 
the top-right of the dialog. It’s 
gained an ‘Automatic layout’ 
option, too… though that doesn’t 
seem to work terribly well, as it’s 
based solely on the dialog’s width 
rather than its aspect ratio. If you 
really want a vertical layout for this 
dialog, better to select it explicitly. 

The rather useless option to hide 
the attributes pane has also been 
removed.

The editing pop-ups have been 
improved with this release. 
Selecting a ‘style’ attribute’s value 
now shows the properties as a 
vertical list, much like you would 
use when writing a CSS file by hand. 
There’s no syntax highlighting in 
here though, unfortunately.

When editing the ‘d’ attribute of 

a path element of some sort (a list 
that includes things like stars and 
spirals, as well as the more obvious 
Béziers and pencil lines), there’s a 
small button and pop-up at the 
bottom of the editor. Clicking the 
button will round the path values 
to the number of digits selected in 
the pop-up, as shown in this before 
and after image.

This is something that can be 
achieved across a whole document 
when exporting as an ‘Optimized 
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SVG’, or more generally by 
adjusting the ‘Numeric precision’ 
value in the ‘SVG Output’ pane of 
the Inkscape Preferences dialog 
(Edit > Preferences), but it’s quite 
nice to be able to do this on a more 
ad-hoc basis here. I imagine this 
might be of use to people creating 
small icons, for example, who want 
to ensure that their path 
coordinates all correspond to whole 
pixel values.

TOUCH SELECTION OF PATH 
NODES

‘Touch selection’ is a long-
standing option in Inkscape that is 

often missed by new users, as it’s 
not triggered by any obvious button 
or toggle in the UI. It’s a feature of 
the Selector tool (F1) whereby 
holding down the ALT key allows 
you to draw a thin red line on your 
page: any element touched by that 
line will be selected when you 
release the mouse button. This 
option has now been made 
available in the Node tool (F2) as 
well.

‘Touching’ nodes with the red 
line isn’t quite as easy as touching 
entire objects, so this is best used 
by roughly drawing a line around 
the nodes you wish to select. 

Inkscape does a pretty good job of 
working out which ones you 
intended to include, and which your 
line is just passing by, so you don’t 
have to be terribly accurate, nor do 
you have to form completely closed 
loops around the nodes.

There’s one big caveat with this 
feature for Linux users though. It’s 
something I’ve discussed several 
times in the past, but it bears 
repeating: most Linux window 
managers use the ALT key for 
window operations. Typically, 
holding the ALT key and dragging 
the mouse (with the button 
pressed) will move the window, 
rather than activate Inkscape’s 
touch mode. There are three 
solutions to this that I’m aware of:
•  Change the settings for the ALT 
key in your window manager
•  Hold the SUPER key at the same 
time as ALT
•  Change the keyboard shortcut in 
Inkscape’s Preferences dialog

I don’t like the first of these, as I 
don’t believe you should be forced 
to make a global change to your 
environment just to support a 
feature in a single application. But 
if you find you’re frequently 
triggering window movements 
through ALT-dragging in other 

applications as well, this might be 
something to consider.

Option 2 is not guaranteed to 
work with all window managers – 
though it’s done the job with all the 
ones I’ve used over the years, and is 
my preferred solution to this 
problem. Simply hold the SUPER 
key (the ‘Windows’ key on most PC 
keyboards) at the same time as ALT 
for any Inkscape functions that 
need the ALT key. This seems to be 
enough to not trigger the window 
manager’s default actions, but 
Inkscape usually ignores the 
distinction and carries on as 
expected. This typically works well 
for features that have a long-
standing history in Inkscape, but 
not for newer additions, as we’ll 
see later.

The third option is to change the 
Inkscape keyboard bindings so that 
this mode is triggered by a key 
other than ALT. I’m not a fan of this 
approach, as it takes you off on a 
non-standard path to using 
Inkscape that might lead to 
confusion when trying to follow 
instructions, YouTube videos, or 
even future instalments of this 
series. But you may prefer it to 
option 1 if the second approach 
doesn’t work. The location of this 
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setting is buried within the 
Preferences dialog (Interface > 
Keyboard > Modifiers tab > 
Selection), so you might want to 
follow the image below as a guide.

SELECTOR TOOL 
IMPROVEMENTS

There’s now an option to enable 
selecting transparent objects. In 
the Preferences dialog, expand the 

‘Behaviour’ section and click on the 
‘Selecting’ entry. The new option is 
the second one in the pane, 
labelled as ‘Select transparent 
objects, strokes and fills’ on my 
system. Enabling this may avoid a 
few trips to the Display Mode menu 
if you have to work with 
transparent objects frequently.

There’s now a way to save and 
restore the current selection, 
though it’s not the easiest thing to 

use. You can access it by pressing 
the ‘?’ key to open the ‘Commands 
bar’, then search for ‘selection 
backup’ to find the commands to 
set, restore, and empty the saved 
selection. It works for selected 
objects or nodes, but you can save 
only one selection at a time, which 
somewhat limits its usefulness. I’ve 
always found Inkscape’s 
implementation of a command 
palette to be a bit clunky, so if you 
do want to use this feature, I’d 
recommend setting keyboard 
shortcuts for the set/restore 
commands, at least.

There’s a keyboard shortcut to 
reapply the last transform. For 
example, if you rotate an object by 
15°, then press CTRL-ALT-T, it will be 
rotated by another 15°. Based on 
what you’ve read so far, Linux users 
might expect to use SUPER-CTRL-
ALT-T to achieve the same result, 
but unfortunately this is one case 
where Inkscape doesn’t treat it as 
the same command. You can 
reassign this feature to that 
shortcut (or any other) via the 
Preferences dialog – search for 
‘Reapply Transforms’ in the 
Interface > Keyboard pane.

It might not be immediately 
obvious to you why you would want 

to use this shortcut. Surely you 
could just rotate by 30° in the first 
place? In theory this could be useful 
for applying the same transform to 
multiple objects, one by one. In 
practice the reapplied transform is 
based on the same rotation origin 
as the original object, which makes 
this less useful for rotating, 
skewing, and scaling. In the rotation 
example, using this feature on a 
second object won’t rotate it in 
place, but rather may send it 
shooting off to another part of the 
canvas entirely, if it’s located some 
way from the first object’s center of 
rotation.

A related feature that might 
prove more useful, though, is 
‘Duplicate and Transform’. By 
default, this is bound to CTRL-ALT-
D, but Linux users will probably also 
have to re-bind this in the 
Preferences dialog, as adding the 
SUPER key to the mix doesn’t work 
by default. With this shortcut, the 
selected object is duplicated and 
has the previous transformation 
applied to it as well. For example 
you might use these steps to create 
several objects that are equally 
spaced:

•  Select an object.
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•  CTRL-D to duplicate it.
•  Drag or otherwise move the 
duplicate to a new location.
•  With the duplicate still selected, 
press CTRL-ALT-D (or the keyboard 
shortcut you’ve set) to create 
another duplicate spaced apart by 
the same amount.
•  Repeat the keyboard shortcut to 
create a series of duplicates with 
equal spacing.

Unfortunately there isn’t an 
equivalent of this for creating 
clones rather than duplicates, 
which is a slightly odd omission 
given the next addition to the 
Selector tool…

You may be familiar with the 
ability to drag an object around the 
canvas and hit the Spacebar to 
‘stamp’ a copy. With 1.3, you can do 
the same but pressing ‘C’ instead of 
the Spacebar, resulting in a clone 
being created each time rather 
than a copy.

The next feature isn’t exactly 
part of the Selector tool, but 
selections play their part. The rulers 
have been improved to provide a 
little more information, including 
some about the current selection. 
They now have a different colored 
background to indicate the page 

boundaries, and a thin blue line, 
with circles at either end, to 
indicate the size and position of the 
current selection.

I’m not sure how useful it is to 
be able to see the size of the 
selection at all times, but it doesn’t 
hurt either. More beneficial is the 
fact that you can now right-click on 
a ruler to set the document units, 
rather than having to do so via the 
Document Properties dialog. As this 
is a global setting for the 
document, it also affects the units 
used for number fields elsewhere in 
the application. If you have to 
switch between multiple units in 
the same document this will 
certainly be faster than opening a 
dialog.

PASTING OPTIONS

The options for pasting in 
Inkscape have increased over the 
years. As well as the most common 
case of pasting objects that have 
been copied to the clipboard, 
additional capabilities have been 
added to allow just pasting the 

width or height, for example, which 
lets you easily set one object on the 
canvas to the same dimensions as 
another. With this increase in 
options, the Edit menu was starting 
to get a little long, so all the 
‘special’ pasting modes have been 
moved to a separate sub-menu, 
simply called ‘Paste…’. This should 
not be confused with the normal 
‘Paste’ menu entry just above it 
(which has no ellipsis after the 
name), which is the one to use for 
simply pasting an object onto the 
canvas. The new menu contains 
these options:

‘In Place’ will paste the object 

back at exactly the same 
coordinates from which it was 
copied. While this may seem the 
same as simply creating a duplicate, 
the difference is that you have the 
opportunity to change layers, enter/
exit a group, or even switch to a 
completely different document 
before pasting. I often use this to 
remove individual objects from 
within a group, but put them back 
at the same location so that the 
drawing looks the same, even if the 
structure has changed a little.

‘On Page’ is new with version 
1.3, and is similar to ‘In Place’ 
except that it is relative to the 
current page in a multi-page 
document. This can be used to copy 
an object from one page to exactly 
the same place on another (e.g. a 
common header or border). Before 
using this, the destination page has 
to be made ‘active’ by selecting an 
object on it, selecting the page 
itself using the Page tool, or by 
changing the current page using 
the pop-up menu in the status bar 
(which is only visible if the 
document contains multiple pages).
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The next three size-related 
entries are pretty simple. Copy an 
object to the clipboard, then select 
another object on the canvas. 
Select Edit > Paste… > Width to 
change the width of the selected 
object to match that of the copied 
object. ‘Height’ behaves similarly, 
and ‘Size’ sets both the width and 
height at once.

If, before choosing these paste 
options, you select multiple objects 
rather than just one, the behaviour 
may not be quite what you 
expected. The width/height/size is 
applied to the entire selection, 
rather than each individual object. 
If you want that behaviour, then the 
last set of options will provide you 
with the desired result. If you have 
only one object selected, then 
either set of options will give the 
same effect.

https://www.peppertop.com
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One of the most welcome 
changes in Inkscape version 

1.3 is the addition of a Pattern 
Editor in the Fill & Stroke dialog. It’s 
definitely not without its issues, 
but it’s such a vast improvement 
over the UI in earlier releases that 
I’m more than prepared to forgive a 
few UX missteps.

First a reminder about patterns 
in general, as they’re not a feature 
that all users have a lot of 
experience with. The short, 
technical explanation is that a 
pattern is a section of SVG content 
that can be used in place of a color 
or gradient for the fill or stroke of 
an object, and which will 
automatically be tiled in both the 
horizontal and vertical directions if 
it’s not large enough to fill the 
required space. Inkscape comes 
with a large number of built-in 
patterns, and it’s those I’ll focus on 
in this article. If you need 
something else, however, you can 
create your own patterns by 
selecting one or more objects in 
your image, and using the Object > 
Pattern > Objects to Pattern menu 
entry.

Let’s look at adding a pattern to 
the fill of a rectangle. In this 
screenshot of the Fill & Stroke 
dialog, the object currently has a 
solid red fill. I’ve drawn a red circle 
around the button that switches 
from a flat color fill to a pattern fill, 
and there’s a similar button on the 
‘Stroke paint’ tab.

Clicking that button in an old 
Inkscape release produces a rather 
underwhelming UI, consisting of 
just a single pop-up selector and a 
lot of explanatory text.

Opening that pop-up presents a 
long list of pattern names, 

consisting mostly of stripes of 
different ratios, some polka dots, a 
few miscellaneous vector entries, 
and three bitmap designs. But one 
thing that’s conspicuous by its 
absence is any sort of preview of 
each pattern – you have to just 
apply each of them to your shape in 
turn to see what they look like. 
That’s it for the UI in the dialog. 
There are some on-canvas handles 
for repositioning and sizing the 
pattern (more on those later), but 
in terms of selecting a pattern you 
just pick the name from a list and 
hope for the best.

Compared with that sparse 
interface, 1.3 offers a wealth of 
controls and previews, to the point 
that it’s almost overwhelming!

With so much more to show, you 
may find that there’s even a 

scrollbar to let you access all of it if 
you have the dialog sized too small. 
Below this UI you’ll also find the 
Blend Mode, Blur, and Opacity 
controls that are common across all 
the fill types, so fitting the entire 



full circle magazine #207 32 contents ^

HOWTO - INKSCAPE
Fill & Stroke UI on screen at once 
requires quite a bit of vertical space 
and is likely to require some 
scrolling up and down on a smaller 
screen.

Let’s break down the various 
parts of this UI to make more sense 
of the features that are now 
exposed, starting from the top:

After the ‘Pattern fill’ label, the 
first actual control is a button with 
a gear icon which opens a pop-up 
with a couple of settings. The first 
of these is a checkbox to turn on or 
off the display of the pattern 
names below each swatch. 
Personally I find that displaying the 
names is largely useless, as you may 
see only the first few characters, 
which are often identical across 
multiple different patterns. 
Hovering over a swatch displays the 
full name in a tooltip, so if you just 
want to know or memorize the 
names of your most commonly 
used patterns, there’s little need to 
have them permanently displayed.

With the slider in this pop-up 
you can adjust the size of the 

pattern swatches (referred to as 
‘tiles’). Larger tiles show more of 
the pattern content (and more 
characters in the name, if you have 
enabled that option), but reduces 
the number of swatches that are 
visible at once. Inkscape tries to 
update the dialog live as you move 
this slider: on my machine this was 
jerky, hanging the UI for a second or 
two with each re-render. I advise 
dragging the slider very slowly to 
allow the application to keep up, 
especially when trying to finetune 
the tile size to your exact 
preference.

Next to the gear button is a 
search field for filtering the 
displayed swatches based on their 
name. With the number of patterns 
in Inkscape at the moment it seems 
unlikely that much use will be made 
of this feature. Perhaps if many 
more designs are added in a future 
release, this will make more sense.

The remainder of this top 
section is taken up by a box that 
shows a swatch for each pattern 
that is used in the current 
document. Note that this is one 
swatch per pattern, not per object 
using a pattern. If you use the exact 
same pattern on, say, five different 
objects it will still appear in here 

only once. Clicking one of these 
swatches will apply the pattern to 
the currently selected object(s) – 
but make sure you read the rest of 
this article to understand the 
difference between picking a 
pattern here versus the next box of 
tiles, as they don’t do quite the 
same thing.

That ‘next box of tiles’ is a 
similar region containing swatches 
for patterns, but this time it shows 
all the ones that are available in the 
application, rather than just those 
that are being used in the 
document (shown above).

At the top-left is a pop-up menu 
that lets you select between 
different categories of pattern. The 
categories are rather arbitrary – 
what makes a pattern ‘Asian’ rather 
than ‘Decorative’ or causes it to 
appear in the ‘Geometrical’ section, 
rather than the confusingly named 
‘Patterns’ group? The real benefit 
to being able to view one group at a 

time is simply that it limits the 
number of patterns to display at 
once, in this scrollable letterbox 
view that is clearly too small for the 
purpose except on the largest of 
screens.

Next to the pop-up are arrows 
that simply step through the 
groups, offering little additional 
benefit. Furthermore, the stepping 
doesn’t wrap around, so when you 
get to the last group you’ll probably 
end up opening the pop-up anyway 
to jump back to the beginning.

Then we have the pattern 
swatches themselves. Clicking a 
swatch in here will apply it to the 
currently selected object(s), but 
again make sure to read to the end 
of this article. Whereas the top set 
of swatches is likely to have only a 
handful of entries at most, this one 
can potentially contain a huge 
number. Not only is this box often 
too small to practically scroll, but 
many of the patterns run into each 
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other in a way that sometimes 
makes it hard to distinguish them 
from each other. Inkscape devs: can 
we have an option for a gap 
between tiles, please?

Finally, we have the largest part 
of the dialog: the section for 
previewing and editing the 
currently selected pattern. This 
consists of a large preview box, 
with a number of fields and 
controls wrapped around it which 
affect the preview, as well as 
having a live effect on the 
pattern(s) on the canvas.

Top-left is a field that holds the 
name of the pattern. You can also 
edit the name here, though your 
changes don’t take effect 
immediately, even if you press the 
Enter or Tab key. Instead you have 
to interact with some other control 
– one of the buttons in this dialog, 
or selecting a different object on 

the canvas, for example. Only then 
does the change kick in, and the 
tooltip on the swatch will update.

Running down the right are 
controls for changing the way the 
pattern appears. You can alter the 
scale in the x and y directions, with 
the ‘(un)broken chain’ toggle that is 
common in many graphics programs 
being used to switch between 
proportional and free scaling. You 
can also rotate the pattern using 
either the ‘Orientation’ field or the 
unlabelled slider beneath it. ‘Offset 
X’ and ‘Offset Y’ are used to adjust 
the placement of the pattern within 
your fill or stroke.

ll of these controls can also be 
changed graphically on the canvas. 
There are two ways to enable this 
mode: the first – which has been 
available in Inkscape for a long time 
– is to switch to the Node tool (F2) 
while an object with a pattern is 
selected; the second is simply to 
click the ‘Edit on canvas’ button in 
the Fill & Stroke dialog, which 
actually just switches you to the 
Node tool anyway.

Whichever approach you take, 
Inkscape will display a square or 
rectangle with three handles on the 
canvas which represents the outline 

of a single tile of your pattern. In 
older releases, this rectangle 
always appeared at the top-left of 
your document, but 1.3 changes 
this so that it appears on the object 
you’re editing. This makes a lot 
more sense, especially if you’re 
trying to adjust the pattern on an 
element that’s far from the top-left 
corner.

The style of the handles, 
however, is rather confusing. They 
look identical to the handles for 
editing a rectangle, such that it’s 
easy to get them mixed up when 
they happen to be close together 
on the canvas. In this image you can 
see the rectangle’s handles around 
the outside, and the pattern’s 
handles inside the object – just 
imagine the confusion when the 
pattern is a similar size to the 
object, so that the handles start to 
overlap. Wouldn’t it make so much 
more sense to render these handles 
with a different shape, color, or line 
thickness?

Dragging the top-left handle will 
reposition the pattern (equivalent 
to the ‘Offset X’ and ‘Offset Y’ 
controls). Dragging the bottom-
right handle will resize the pattern 
(equivalent to ‘Scale X’ and ‘Scale 
Y’) – hold Ctrl at the same time for 
proportional scaling. When scaling 
proportionally, the handle fixes the 
aspect ratio that is currently set, 
rather than forcing x and y to the 
same value. This is a good thing, as 
it lets you set the aspect ratio for 
the pattern then adjust its actual 
size without that ratio changing, 
but there doesn’t seem to be a 
shortcut to force it back to a 1:1 
ratio, should you wish to, leaving 
you to edit the fields in the dialog 
instead. Finally, dragging the round 
handle at the top-right will rotate 
the pattern (equivalent to the 
‘Orientation’ field and slider).

If your pattern is small enough 
to repeat within your shape, 
clicking within it will move the 
handles to the corresponding ‘copy’ 
of the pattern. If your pattern is 
larger than the shape it’s applied 
to, the handles can appear outside 
the object, as in this example with a 
large rotated pattern.
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Within the dialog is also a pair of 
sliders labelled as ‘Gap X’ and ‘Gap 
Y’. These allow you to add gaps 
between the copies of your pattern 
but, quite frankly, they feel like an 
afterthought. The size of the gap is 
represented on them as a 
percentage (of what?), but they 
allow steps of only 20% at a time – 
and there’s no input field to enter 
an arbitrary value. Digging into the 
XML editor, I think that these 
actually set the ‘width’ and ‘height’ 
attributes on the <pattern> 
element (which is hidden away in 
the <defs> section), with the 
percentages being based on the 
width/height of the pattern 
content. They’re certainly not 
stored as simple percentages in the 
XML, so if you want a value that 
doesn’t fall on a 20% step, you’ll 
have to do the math, or manually 
tweak the values in the XML editor, 

until the result looks right.

Now that I’ve explained the bulk 
of the pattern editing controls, we 
get to one of those caveats I 
mentioned earlier. If you click on a 
swatch to select a pattern – even if 
it’s the same one that’s already 
been applied to your object – all 
those fields are reset to their 
defaults. On the one hand, this is a 
quick and easy way to revert all 
your changes if you’ve been playing 
around with the handles on the 
canvas, but on the other hand, it’s a 
quick and easy way to accidentally 
revert some carefully curated 
changes in a way that you might not 
spot until it’s too late for Edit > 
Undo to save you.

There’s one final control I 
haven’t described yet, which you 
might think I’ve skipped over 
because it’s so obvious what it 
does: the ‘Color’ button (labelled 
‘Colour’ in the screenshots from my 
British English installation). 
Unfortunately, while it is indeed 
obvious what it should do… it 
doesn’t always do it.

With some patterns, selecting a 
color will change the pattern to 
that color, as you might expect. But 
with others, it doesn’t have an 

effect at all, or the button simply 
doesn’t do anything (it’s disabled, 
but although the label appears 
greyed out, the button itself 
doesn’t look obviously inactive in 
any way). Take these five patterns – 
the last five of the ‘Patterns’ group 
– and see if you can predict how 
each one will behave when I try to 
apply the same color to them?

The first (“Stripes 13 (4:1)”), is a 
simple vector pattern, and accepts 
the color as you might expect. The 
second (“Table Cloth”) disables the 
button, which I guess makes sense 
given the mixture of colors in the 
pattern. But although the third one 
(“Tiles”) also appears to contain 

multiple colors, it will happily 
accept a color change. The fourth 
pattern (“Tiles 2”) will let you open 
the color picker and set a value, but 
then it still appears in only black. 
The last one (“Wavy”), despite 
looking like a simple vector pattern, 
also disables the button. Here are 
those results, in graphical form, 
with the default appearance in the 
top row, and the bottom showing 
all the patterns after (trying to) set 
them to pure red.

There’s one more caveat to 
using this dialog, and it’s a very, 
very important one. Depending on 
how you use it, Inkscape will 
sometimes create a copy of a 
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pattern, and sometimes it won’t. 
This can have a huge effect on what 
happens when you play with the 
editing controls, and makes the 
result very hard to predict.

If you set a pattern fill by 
clicking on the top section of the 
dialog – i.e. choosing a pattern that 
has already been applied to 
another object in your document – 
both those objects use the same 
pattern definition. If you change 
the color on one of them, the other 
one will change as well.

If you now change the other 
pattern controls for one of those 
objects, such as the scale or 
orientation, Inkscape creates a new 
pattern which references the first, 
but applies its own position and 
transformation data. Other types 
of data are inherited from the 
referenced pattern though. This 
means that even though there are 
now two patterns, they still share 
the same color data, so changing 
the color of one will still also 
change the color of the other.

Now draw another shape and 
set a pattern on it. This time select 
it from the main section of the 
dialog, using the large list of 
grouped patterns. Even if you 

select the same basic pattern as 
above, Inkscape creates a fresh 
copy of it, not just a reference. You 
can change the color of this one 
without it affecting anything else.

If this sounds confusing, it’s 
because it is. Sometimes Inkscape 
creates a copy, sometimes it 
creates a reference to an existing 
pattern. There’s some logic to it, 
but nothing that’s very obvious 
from a user’s perspective. I’ve 
distilled the complexity down into 
two rules, which should hopefully 
help you to make the right choice 
when setting a pattern:

1/ If you want an independent 
pattern for your object that will not 
be affected by changes to the 
pattern on other objects, make sure 
to select it from the main list of 
swatches, not from the top region 
that shows the ones already applied 
in the document.

2/ If you want objects to share the 
same pattern such that changing 
the color of one changes the 
others, select the pattern from 
those that are already in the 
document, using the top section of 
the dialog. The on-canvas controls 
for setting scale and orientation (or 
those at the bottom right of the 

dialog) will still operate on each 
element separately though.

https://www.peppertop.com
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I’ve looked at using clipping paths 
in Inkscape on several occasions 

in this series. This time, I’m going to 
hark all the way back to part 32, 
which appeared in FCM #92 in 
December 2014! In that article, I 
looked at some clipping techniques 
that could be applied to any type of 
object, but which were particularly 
suited to bitmap images. I used this 
familiar lady as my subject.

The highest resolution version 

of this file weighs in at nearly 
90MB, so it’s not the sort of thing 
you’d want to embed into an SVG 
file – especially not multiple times. 
One solution to this is to link the 
image into your Inkscape document 
rather than embed it, but there are 
occasions when embedding is the 
better option. The classic example 
of this is when you want to share 
the file with somebody else. 
Inkscape will also sometimes use 
absolute rather than relative paths 
when embedding images, which 
makes them less practical to move 
between systems. You can manually 
edit the paths to make them 
relative, which helps the situation a 
lot, but you’re still left with an 
Inkscape document that actually 
consists of two or more files that 
have to be moved as one. 
Embedding images solves all these 
problems, but this comes at the 
cost of a larger file, since it now 
contains a copy of the bitmap data 
in a text-based encoding that bloats 
it even further.

The main subject of part 32 was 
therefore how to avoid embedding 
multiple copies of an image in your 

document when you need to 
reference different parts of it. The 
example provided was of an 
information leaflet that contains 
clipped images of La Giaconda’s 
head and hands.

Despite appearances, the 
document in this screenshot 
contains only a single copy of the 
original image file. The secret is 
well known to Inkscape veterans, 
but is perhaps the single most 
useful tip I can provide when 
working with clipping paths (or 
masks): the content to be clipped is 
placed inside a group.

That alone isn’t enough to get 

this effect, but it’s a prerequisite 
that makes for a good tip in 
general. With the clipping path 
applied to the group rather than 
the image itself, you can still 
double-click to enter the group, 
then move the image within it to 
change the point of focus. What 
you can also do is clone the image 
within the group, then cut it to the 
clipboard, exit the group, and paste 
it somewhere else (even on 
another layer). Because you’ve 
cloned the image itself, not the 
clipped group, you get a complete 
copy of the image that can be 
further manipulated. In this case, 
the requirement was to clip the 
clone to show only the hands, and 
position it beside the head.

While we’re on the subject of 
clipping tips, another useful tip is to 
always convert your clipping shape 
into an actual path if it’s not already 
one. That means any rectangles, 
ellipses, stars, or regular polygons, 
that you want to use as a clipping 
path, should generally be converted 
using the Path > Object to Path 
menu entry before you apply the 
clip. The reason? It means that the 
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path can be edited using the Node 
tool (F2) without unclipping first, 
which is not only a time-saver but 
also gives you a more 
representative view of how the 
final clipped object will look while 
you’re editing the path. Note that 
this capability can be toggled on 
and off when the Node tool is 
selected, by using this button in the 
toolbar; so make sure it’s enabled if 
necessary.

This is all well and good, but this 
month’s column isn’t really about 
repeating some tips from a decade 
ago, no matter how useful they still 
are. Instead, I want to talk about a 
new feature in Inkscape 1.3 which 
might make the previous approach 
redundant… at least in some cases.

Looking back at the original 
requirement, the aim was to cut 
out two sections from the original 
image which could then be moved 
around and manipulated 
independently. Although the 
group-and-clone technique 
achieved this visually, it didn’t really 
“cut out” the sections at all. The 
final pieces were just clipped 

versions of the full-sized image – 
which becomes very obvious when 
you look at the bounding box when 
I select one.

Obviously there’s at least one 

copy of the entire image embedded 
into the Inkscape document, even 
though the vast majority of the 
pixels don’t appear in the final 
output. All those invisible pixels still 
contribute to the file size.

The most obvious way to avoid 
this is to edit the original image 
using a bitmap editor such as The 
GIMP or Krita, but that assumes you 
know how to use such programs to 
slice your image into individual 
parts, and save them as separate 

files. Wouldn’t it be nicer if Inkscape 
could take care of this for you, 
using the tools you already know? 
Well now it can.

To demonstrate I’m going to 
drag and drop my image into the 
Inkscape window. By default, you 
will be prompted as to whether you 
wish to link or embed the file, and 
I’ll choose to link it. 

If you don’t see that dialog then 

you likely clicked the “Don’t ask 
again” checkbox on a previous 
occasion. It doesn’t really matter 
too much whether the image is 
linked or embedded at this point (it 
will end up embedded by the end 
anyway), but I prefer to link it to 
avoid bloating the SVG file when I 
save incremental work-in-progress 
copies of the file. If you do want to 
reinstate this dialog, then open the 
Inkscape preferences (Edit > 
Preferences), select the “Imported 

Images” entry on the left, and 
ensure that you check the “Ask 
about linking and scaling when 
importing bitmap images” option.

In this particular case, I want to 

use two sections of this image, but 
this technique is just as applicable 
to a single clipping path on a single 
image, should you want to remove 
the extraneous pixels that take up 
space in your SVG file. But, for two 
sections, I need two copies of the 
image: not clones this time, but real 
copies. Selecting my imported 
image and duplicating it (Ctrl-D) 
does the job. If you embedded the 
image, then saving at this point will 
result in a very large file, with the 
content of your image stored twice 
in the SVG file. If you linked the file 
there will be no such concerns, and 
your SVG file remains almost as 
svelte as ever.

Now I’ll create the clipping paths 
that mark out the sections of the 
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images that I want to keep. The tip 
about converting any primitive 
objects to paths still applies. Here’s 
how my document looks so far with 
my clipping paths given a bright 
green stroke as is my usual 
preference.

The next step is to select one 
image and its associated clipping 
path, and apply the clip. I usually 
right-click and select ‘Set Clip’ from 
the context menu, but Object > Clip 
> Set Clip does the same thing if 
right-clicking isn’t practical for you. 
Repeat for the other image and 

path.

This is the time to get the shape, 
position and size of your clipping 
paths absolutely perfect. We didn’t 
group the image first, so the trick 
of double-clicking to move the 
focus won’t work here. But we can 
switch to the Node tool and move 
the entire clipping path if necessary 
– just select all the nodes (Ctrl-A 
will do the job) and you can drag 
the entire thing around. Of course 
you can also edit individual nodes 
to change the shape of the path. If 
you need to change its size, but not 

its shape, select all the nodes and 
use the ‘<’ and ‘>’ keys. ‘[‘ and ‘]’ will 
similarly rotate the path.

Right, are you happy with the 
clipping? Make sure you are, 
because once you take the next 
step, Inkscape will throw away 
much of the original image, so 
there’s no turning back. (Okay, Ctrl-
Z works to undo as usual, but what I 
mean is that this is a destructive 
change that can’t be undone once 
you’ve closed and reopened the file 
later).

Right-click on one of the clipped 
images and you should find a new 
entry in the context menu: “Crop 
Image to Clip”. Select that, and 
Inkscape will throw away the 
hidden pixels… sort of. The reason 
for that caveat is that there aren’t 
any widely used bitmap formats 
that support non-rectangular 
images, so in the case of a non-
rectangular clipping path, you’ll still 
find that some hidden pixels remain 
(you can remove the clip to see 
them). But for all practical 
purposes, your image has been 
reduced to just the clipped area, 
even if a few extraneous pixels are 
technically still present in the 
corners.

Now it would be a big problem if 
Inkscape clipped a linked image in 
this way. You wouldn’t want 
Inkscape to destructively modify 
your original image. What happens 
if that same image is linked into 
another document, perhaps in a 
completely different application? 
For that reason, Inkscape embeds 
the destructively edited image file 
if it was originally linked. In the case 
of our example document, 
therefore, this means we’ve 
embedded two small images – one 
of the head and one of the hands – 
but the combined size of those two 
pictures is still likely to be 
significantly less than our single 
embedded file using the previous 
approach.

Our final cropped and clipped 
images can now be positioned and 
manipulated as normal, with the 
advantage that the bounding boxes 
look a lot more sensible.

This new feature will be useful 
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in a lot of cases where users want 
to use Inkscape to clip or crop 
bitmap images, but it’s not a 
panacea, and needs to be used with 
consideration for its merits and its 
drawbacks. Where your clipping 
path encompasses most of the 
image – just removing a small 
amount from around the edges – 
it’s probably not worth using this 
technique. The savings in file size 
will be minimal, and the destructive 
nature of the editing means you’ll 
lose some ability to tweak and 
refine your clipping path or image 
position later on.

The example I used here does 
make sense… but if we’d wanted 
larger areas, or boxes that overlap 
the same part of the original image, 
the file size might not actually get 
much smaller. Each embedded 
cropped image carries some 
overhead, so it’s even possible that 
taking multiple views in this way 
could result in a larger SVG file than 
if the entire original image was just 
embedded once.

The feature itself is not very 
discoverable. You have to have 
already applied a clip to an image 
directly (not an image in a group), 
and only then does it appear in the 
context menu. Why can’t we have a 

“Crop and clip” context menu entry 
that does both steps as one?

It’s also worth noting that this 
applies to only bitmap images. For 
simple vector shapes, the 
equivalent method is to use the 
Boolean operations, but for 
complex groups of objects, there is 
no easy equivalent that will cut 
away the parts of objects that are 
not visible due to clipping. While 
the file size argument is less 
pressing with vector objects, there 
are times when it would be nice to 
be able to ‘tidy up’ an image in a 
similar way. I suspect there are too 
many edge cases for that to be an 
easy thing for the developers to 
achieve, though.

Overall I think this is a very 
useful addition to Inkscape’s 
arsenal. It’s just a shame that the 
lack of discoverability means that 
the people who will most benefit 
from it – the new users who also 
aren’t comfortable with bitmap 
editors – are those most likely to 
miss it. If you know someone like 
that, point them in the direction of 
this article.

IMAGE CREDITS

“La Gioconda” (aka “Mona Lisa”) 
by Leonardo da Vinci
http://en.wikipedia.org/wiki/
File:Mona_Lisa,_by_Leonardo_da_V
inci,_from_C2RMF_retouched.jpg
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As I write this, the third beta for 
Inkscape 1.4 has just been 

released, primarily fixing some 
Windows issues. I encourage any 
readers who are so inclined to 
download the beta versions, try 
them out, and report any issues 
they find. If you’re not a 
programmer, it’s perhaps one of 
the best ways to contribute back to 
Open Source software, helping to 
ensure that the quality of the final 
release is as high as possible.

Despite version 1.4 looming 
large on the horizon, there are still 
a couple of features from 1.3 for 
me to cover. This month, I’m going 
to look at some new on-canvas 
controls that have been added. As 
has often happened with Inkscape, 
these controls don’t actually 
provide any new functionality, but 
they do expose existing features in 
the UI in a way that might make 
them more discoverable, or easier 
to access, when you need them.

The first of these is on-canvas 
editing of corners for paths and 
other shapes. In other words, the 
ability to turn sharp corners into 

fillets (curved corners) and 
chamfers (angled corners) directly 
on the canvas. This brings Inkscape 
somewhat up to parity with other 
applications which often offer such 
functionality, but there’s a good 
reason why it wasn’t present 
previously: the SVG file format.

SVG doesn’t support filleted or 
chamfered corners, other than 
through them being drawn as real 
path segments. Inkscape often gets 
around such limitations through 
the use of Live Path Effects (LPEs). 
These are a means by which 
Inkscape can store the ‘original’ 
path or object data in its own 
custom fields, while also creating a 
version of the shape using ‘normal’ 
SVG paths, so that other 
applications can still render the 
result. Those applications won’t 
have the same editing capabilities 
as Inkscape, but at least the end 
result can still be displayed and 
used, even if some of the Inkscape-
specific editing options are lost.

LPEs have been exposed as on-
canvas tools before: if you draw a 
Spiro path using the Pen tool (aka 

the Bézier tool) or the Pencil tool, 
Inkscape automatically adds the 
Spiro LPE to produce the effect. 
Creating a BSpline similarly adds 
the BSpline LPE, while selecting a 
shape for the path (e.g. Ellipse or 
Triangle In) adds the Pattern Along 
Path or Power Stroke LPE. These 
effects stack, so drawing a Spiro 
path with the Triangle Out shape 
adds both the Spiro and Power 
Stroke LPEs.

This approach does a good job 
of hiding the complexity of the 
main LPE dialog, while still allowing 
more advanced users to edit the 
LPE parameters directly, or flatten 
the path to remove the overhead of 
the LPE calculations. In the same 
manner, the new on-canvas editing 
of corners exposes the Corners LPE 
in a more intuitive way, while still 
allowing access to the LPE 
parameters if necessary.

To begin, let’s use this feature 
on a simple path drawn using the 
Bézier tool. Here’s how my semi-
random shape looks with the Node 
tool selected (F2).

With the Node tool still 
selected, we can add the Corners 
LPE simply by clicking a button in 
the tool control bar (outlined in red 
in this image). Note that clicking it a 
second time removes the LPE, 
losing any changes you’ve made, 
though Edit > Undo (Ctrl-Z) should 
save you if you click it by mistake.

Note that the button doesn’t 
appear as a visible toggle: it doesn’t 
change state when the LPE is 



full circle magazine #209 33 contents ^

HOWTO - INKSCAPE
applied. The most obvious way to 
tell, however, is just to take a look 
at your path, which will have gained 
a new handle by each node (the 
small round circles in this image).

Drag any of those handles to set 
the fillet radius for the corner. As 
you do so, the single circular handle 
will be replaced by two triangular 
handles, allowing further tweaks to 
the radius to be made from either 
side of the underlying node. 
Dragging a few of these handles 
makes it very easy to turn our 
sharp, spiky shape into a mixture of 
spikes and curves.

Holding Control while clicking 
on any of these handles will cycle 
the corresponding node through 
the various types of corner that the 
LPE offers: fillet, inverse fillet, 
chamfer and inverse chamfer. The 
latter two appear identical at this 
point, just cutting off the corner 
with a straight line, but we’ll do 

something more interesting with 
them in a moment. For now, here’s 
what the same corner looks like in 
each mode.

At this point it’s worth noting a 
small bug when using anything 
other than a normal corner or fillet. 
If you copy and paste, or duplicate 
your shape, the LPE sometimes 
loses track of the type of corner 
you had selected, so inverse fillets, 
or either type of chamfer, are 
converted to normal fillets in the 
new object. The behaviour is a little 
erratic so this is just something to 
keep an eye out for, though you 
may get lucky and never be 
affected by it.

For setting the position of the 
corner handles there’s a useful trick 
that can save a lot of time with 
complex paths. If you have any 
nodes selected, their handles will 
also be modified to match the same 

relative position of the one you’ve 
dragged (whether the drag handle 
is on a selected node or not). This 
makes for a quick way to set all 
corner handles to the same relative 
position by pressing Ctrl-A to select 
all the nodes before dragging. 
Unfortunately, Ctrl-Clicking to set 
the corner type still only works on 
the clicked handle, regardless of 
any selected nodes. It is possible to 
set the type for all nodes, or all 
selected nodes, at once via the 
main LPE controls. See part 121 of 
this series (FCM #181) for more 
details about the controls and 
parameters available via the LPE 
dialog.

Shift-Clicking on a handle opens 
a small dialog that allows you to set 
various parameters for that specific 
corner:

This is an alternative way to set 
the corner type, or to accurately 

position the handle (labelled as 
‘Knot distance’ in the dialog), but it 
also offers one other field to set 
the ‘Chamfer subdivisions’. 
Increasing this beyond 1 reveals the 
difference between a chamfer and 
an inverse chamfer. This image 
shows each type of corner, with 1, 2 
and 3 subdivisions.
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So far we’ve looked at using this 
feature on paths, but it also works 
on 2D shapes. Squares, rectangles, 
and the shapes created with the 
Star/Polygon tool, seem like 
obvious candidates, due to their 
sharp corners, but you might be 
surprised to find that this feature 
can also be useful on circles and 
spirals. This image shows a spiral, 
rectangle, star and circle, with the 
corners LPE applied and edited on-
canvas to give you an idea of the 
sort of effects you can now easily 
achieve.

As well as the on-canvas editing 
of corners, Inkscape 1.3 also 
introduced some on-canvas handles 
for editing blurs. You may already 
be aware that blurs in Inkscape are 
implemented using SVG’s Gaussian 
Blur filter primitive and can, of 
course, be added via the Filter 
Editor dialog. This is a rather tricky 
part of the UI for beginners (and 

many experts) to understand, but 
because blurring an object is a 
pretty common requirement, 
Inkscape has always offered a 
shortcut in the form of the slider at 
the bottom of the Fill & Stroke 
dialog.

The slider in this dialog is fine 
for most cases where you simply 
want the object to be blurred in all 
directions. But the UI in the Filter 
Editor actually splits the blur into 
separate controls for the amount of 
blur in the horizontal and vertical 
directions. Usually the little ‘chain’ 
button next to the controls links 
both sliders so that the values 
remain identical, giving the same 
effect as the slider in the Fill & 
Stroke dialog. But toggle that 
button and you can set each slider 
separately – ideal for ‘motion blur’ 
effects which only occur in one 
direction.

The new on-canvas UI provides 

the best of both options: separate 
controls for the horizontal and 
vertical blur, but with the ability to 
easily set both to the same value. 
The only tricky bit is getting the 
controls to appear in the first place!

This feature appears only when 
the Node tool (F2) is selected. But 
unlike the Corners LPE, there’s no 
button in the toolbar to make the 
handles appear. Instead they are 
only visible if the object you’re 
editing already has the blur effect 
applied. This does make the 
handles a little redundant, in my 
view, as you’ll have already had to 
interact with the Fill & Stroke slider, 
the Filter Editor, or one of the 
predefined blur filters, in order for 
the on-canvas controls to appear. 
They’re possibly useful for fine-
tuning the blur in the context of the 
rest of your drawing, but it would 
be nice if there was a toolbar 
button to add and remove a simple 
blur filter in the same way as the 
Corners LPE can be toggled on and 
off.

Your first step, therefore, is 
probably to select your object and 
open the Fill & Stroke dialog. There 
are various ways to do this, from 
the Object menu or keyboard 
shortcut (Ctrl-Shift-F), through to 

my preferred method, which is just 
to click on the Fill or Stroke color 
swatches at the bottom left of the 
window, below the palette. Or you 
may be the sort of person who 
always has it open in a sidebar and 
just needs to make sure the right 
tab is active. Whichever approach 
you take, you then need to nudge 
the Blur slider up a little. I 
recommend just a single click on 
the ‘+’ button at the right,: that’s 
enough to add the effect, but not 
so much that it has a significant 
effect on Inkscape’s redraw speed.

Now switch to the Node tool, if 
it’s not already selected, and you 
should find that the object has an 
additional pair of circular handles, 
just outside the bounding box. In 
this screenshot, I’ve put my object 
over a black background to make 
the white handles stand out a little 
more:
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The handles will always be 
perpendicular to each other, with 
one at the top and the other at the 
right for newly created objects. If 
you’ve rotated the object, however, 
they may not appear in this 
orientation. The handles give an 
indication of the direction that the 
blur will take (if you don’t have a 
uniform blur in all directions), so 
can act as a flag that you might not 
be blurring in the direction you 
want to! A quick tip in that case is 
to remove the blur from the object 
itself (set it to zero in the Fill & 
Stroke dialog), then group the 
rotated object – it’s fine for it to be 
in a group of its own, with nothing 
else in it. If you add a blur to the 
group, you’ll now find that the blur 
is back to the default orientation, 
while your object remains rotated. 
Another tip, if you do need to work 
with rotated blurs, is to remember 
that Inkscape can now rotate the 
canvas during editing. See part 98 
of this series in FCM #158 for 
details.

With the handles visible, it’s 
rather obvious how you can adjust 
the blur on-canvas. Dragging either 
handle will adjust the blur in that 
direction. Hold the Control key at 
the same time to adjust both 

handles to the same value – you’ll 
usually want to do that unless you 
specifically require an asymmetric 
or motion blur effect.

You can also hold both Shift and 
Control to adjust the handles 
proportionally. That is, if the 
handles have different values then 
dragging one will cause the other 
to move by an amount that is 
proportional to the difference 
between them. In other words, use 
this if you have an asymmetric blur 
and want to preserve the overall 
direction while adjusting its 
strength. There is a big caveat to 
this feature, however: if the handle 

has a value of 0 when you start 
dragging then Inkscape’s maths can 
sometimes go awry, sending the 
other handle zooming off towards 
infinity and blurring the object so 
much that it might even disappear 
from view, replaced by a slight 
smudge on the canvas. The solution 
is to nudge the handle above zero 
first with no modifiers held before 
trying to drag it proportionally with 
Ctrl-Shift.

These new additions to on-
canvas editing definitely improve 
the usability of Inkscape, especially 
in the case of the Corners LPE. One 
concern, however, is that Inkscape 

is stacking up ever more handles on 
the canvas, leading to potential 
confusion about what feature any 
given handle corresponds to. Just 
take a look at this image of my 
random shape from earlier, once 
I’ve added a pattern fill, changed 
the type of some of the nodes, and 
added a little blur. That’s too many 
handles for me to make sense of – 
and I know what each of them are 
for! Could we end up in a situation 
where each of these additions, 
intended to make the program 
more user-friendly, actually 
combine to scare new users away 
from the complexity they see on 
the canvas?

Mark uses Inkscape to create comics 
for the web (www.peppertop.com/) 
as well as for print. You can follow 
him on Twitter for more comic and 
Inkscape content: 
@PeppertopComics

https://www.peppertop.com

